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„Napredovanje u karijeri, bilo akademskoj ili profesionalnoj, sve više zavisi od 

sposobnosti pojedinca da komunicira sa različitom publikom.“1 (Mustafa Čengić) 

 

PREDGOVOR 

 

U stalnom nastojanju da unaprijedi kvalitetu nastavnog procesa, Ekonomski fakultet u 

Sarajevu, među ostalim aktivnostima, kontinuirano priprema priručnike i uputstva za 

studente. Četiri priručnika su već dostupna studentima: „Uputstvo za izradu seminarskog i 

diplomskog rada“, „Priručnik za izradu studije slučaja“, „Priručnik za obavljanje ferijalne 

prakse“ i „Vodič za brucoše“. Peti priručnik u ediciji, priručnik za pripremu PowerPoint 

prezentacije, zamišljen je kao podrška studentima ne samo u procesu studiranja, već i u 

procesu njihovog daljnjeg profesionalnog razvoja.  

 

Prezentacije uz upotrebu PowerPoint-a već duže vrijeme predstavljaju osnov uspješne 

komunikacije sa poslovnim partnerima i publikom. Pravilno predstavljanje ideja, znanja i 

stavova drugima, osnova je budućeg poslovnog uspjeha. Vještine prezentacije u poslovnom 

svijetu pokazuju profesionalnost, ozbiljnost i stručnost osobe ili projektnog tima.  

 

Ključne karakteristike kvalitetne prezentacije su jasnoća, konciznost i jednostavnost. 

Priprema prezentacije i uspješno izlaganje pred publikom vještine su koje se mogu brzo 

savladati. Ovaj priručnik sadrži niz korisnih savjeta o procesu oblikovanja prezentacije, 

tehničkoj pripremi i o samoj izvedbi prezentacije. Vjerujemo da će u tom smislu Priručnik 

biti koristan studentima, kako tokom studija na Ekonomskom fakultetu, tako i u kasnijem 

profesionalnom radu.  

 
 
         Autori 

                                                 
1 Mustafa Čengić, Vještina pisanja,, (Sarajevo: DES, 2005.), p. 165. 
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I OBLIKOVANJE PREZENTACIJE 
 
1. Pojam i svrha prezentacije 
 
Prezentacija je oblik komunikacije koji ima slijedeće karakteristike: 

• Prezentacija je javna, sinhrona i najčešće usmjerena na veći auditorij. 
• Prezentacija je svrhovita, organizovana, strukturirana i planirana. 
• Prezentacija je vremenski ograničena. 
• Prezentacija se obično izvodi u formalnijem okruženju i uz upotrebu formalnijeg 

načina izražavanja. 

Svrha prezentacije - ono što se prezentacijom želi postići - može biti: 
• da informiše i objasni (spoznaja i razumijevanje), 
• da uvjeri (prihvatanje ideja), i/ili 
• da motivira (davanje razloga za akciju). 

 

2. Faze u pripremi prezentacije 

Osnovne faze u pripremi uspješne prezentacije su: 
I  Odabir teme i određivanje svrhe 
II  Prikupljanje materijala 
III  Analiziranje publike i okolnosti  
IV  Oblikovanje prezentacije  
V  Vježbanje i konačna provjera 

 

2.1. Odabir teme i određivanje svrhe 

Naprije trebate odrediti o čemu želite govoriti, koja je tema vaše prezentacije. Drugo bitno 
pitanje koje sebi treba postaviti jeste šta želite postići prezentacijom; koja je njena svrha, 
njena glavna ideja, njen opšti cilj? Da li je cilj uvjeriti publiku u nešto, podstaći je ili je 
zabaviti? Pored opšteg cilja trebate odrediti posebne ciljeve za svaki dio prezentacije. Time 
postižete da svaki dio vaše prezentacije ima smisao i da uvijek znate u kojem pravcu 
razvijate prezentaciju. 

Trebate sebi postaviti slijedeća pitanja: 
• Zašto im ovo govorim – sada? 
• Zašto ovo radim – sada? 
• Kakav efekat želim ostvariti? 
• Kakve rezultate želim postići?2 

                                                 
2  Andrew Leigh i Michael Maynard, Savršena prezentacija: Put i način da uspete od prve, Prevod, (Beograd: 

Javno preduzeće „Službeni glasnik“ i Institut za ekonomiku i finansije, n.a.), p. 68. 
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2.2. Prikupljanje materijala 
 
Nakon što odresite šta želite postići prezentacijom, slijedeći korak je prikupljanje materijala 
iz različitih izvora - prikupljanje ideja, citata, statističkih podataka, fotografija, ilustracija, 
anegdota i sl. Prikupljajte i slike, metafore, analogije i simbole, koji mogu značajno 
doprinijeti atraktivnosti i razumljivosti vaše prezentacije.3 
 

2.3. Analiziranje publike i okolnosti 
 
Dvije ključne odrednice vezane za publiku su: 

• Da je upoznate, 
• Da se stavite u njenu poziciju. 

 
Prostor u kojem će se održavati prezentacija takođe treba upoznati i, ako je moguće, 
prilagoditi svojim potrebama. Ujedno je neophodno izabrati i organizovati adekvatna 
pomoćna tehnička sredstva za izvođenje prezentacije. 
 
O upoznavanju publike i o prostoru biće više ćemo govoriti u dijelu o osnovnim 
elementima prezentacije. 
 
2.4. Oblikovanje prezentacije 
 
Osmišljavanje i oblikovanje prezentacije obuhvata slijedeće postupke: 

• određivanje ključnih elemenata i strukture prezentacije, 
• pisanje nacrta i teksta,  
• izradu plana prezentacije, 
• pisanje zabilješki. 

 

2.4.1. Određivanje ključnih elemenata prezentacije  
 
Prezentacija treba biti odgovarajuće dužine – ni prekratka, ni preduga. Iz tog razloga bitno 
je da se u oblikovanju prezentacije koncentrišete na ključne dijelove. U ovoj fazi najprije 
utvrdite tri (maksimalno sedam) ključne stvari koje publika treba saznati.  
 
„... Najčešći problem nije premalo, već previše materijala... Prikupljenii materijal 
klasifikujte na slijedeći način: 

• Informacije koje se moraju znati. 
• Informacije koje se trebaju znati. 
• Informacije koje je dobro znati. 

                                                 
3  Ibidem, p. 26. 
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«Nakon odabira informacija koje se MORAJU znati, možete uključiti ili izostaviti ostale 
informacije.»4 
 
Zatim napišite nacrt – «nabacajte» ideje, rečenice, teze. Tek poslije sređujte tekst. 
 

2.4.2.  Struktura prezentacije 
 
Struktura prezentacije treba biti logična. Univerzalno primjenjiva struktura prezentacije 
sastojala bi se od slijedećeg5: 

• Recite im ono što namjeravate da im kažete. 
• Recite im. 
• Recite im ponovo ono što ste im rekli. 

 
Dakle, prezentacija treba imati uvod, glavni dio i zaključak. 
 
Uvod mora biti efektan, atraktivan i upečatljiv. Uvod podrazumijeva slijedeće korake: 

I  pozdravljanje prisutnih,  
II  predstavljanje (lično ili od strane nekog drugog), 
III  privlačenje pažnje, 
IV  upoznavanje publike sa temom (najčešće se radi o navođenju ciljeva i sadržaja 

izlaganja). 
 

Da privučete pažnju publike, možete pripremiti neku anegdotu, karikaturu, prigodan citat, 
primjer, intrigantno pitanje, kratku dramatičnu ili kontraverznu misao, neku neočekivanu 
radnju ili nešto slično. 
 
U glavnom dijelu prezentacije razvijate i argumentujete glavne ideje. Slijedi nekoliko 
savjeta o tome kako prezentirati glavni dio: 

• Razvijajte interakciju. 
• Argumentujte prezentirane teze. 
• Koristite primjere. 
• Ponavljajte i rezimirajte ono što je prethodno rečeno. 

 
Veoma je važno razviti interakciju – treba nastojati što više uključiti publiku u svoju 
prezentaciju, što se postiže postavljanjem pitanja koja potiču na diskusiju, davanjem kratkih 
zadataka za individualni rad ili rad u grupama itd. 
 

                                                 
4   Andrew Leigh i Michael Maynard, Savršena prezentacija: Put i način da uspete od prve, Prevod, (Beograd: 

Javno preduzeće „Službeni glasnik“ i Institut za ekonomiku i finansije, n.a.), p. 32. 
5  Ibidem, pp. 27-28. 
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Takođe poželjno je publici odrediti tačno vrijeme za postavljanje pitanja, npr. nakon 
izlaganja prezentatora. 
 
Zaključak prezentacije treba predstavljati sažet sinopsis glavnih tačaka. Ne bi trebalo 
iznositi nove informacije, već kratko i logički povezati one već prezentirane. Također taj 
dio može sadržavati odgovore na pitanja koja ste eventualno postavili na početku 
prezentacije, te dati neku važnu tvrdnju ili zanimljiv primjer. Zaključak možete završiti i 
postavljanjem pitanja o kojem publika treba razmisliti, ali o kojem nećete voditi daljnju 
diskusiju. Prezentacija se obavezno završava zahvalom publici na pažnji i učešću. 
 

2.4.3. Plan prezentacije 
 
Prezentacija se mora održati prema određenom planu. Prezentator se mora pripremiti i 
uvježbati kako će početi, razvijati i završiti prezentaciju. Napraviti plan prezentacije znači 
odrediti: 

• Koliko vremena ćete posvetiti pojedinim dijelovima prezentacije? 
• Šta ćete posebno naglasiti u prezentaciji? 
• Gdje ćete napraviti pauze? 
• Gdje ćete potaći diskusiju? 
• Gdje ćete koristiti vizuelne efekte?  

 

2.4.4. Zabilješke 
 
Zabilješke omogućavaju efektivno izvođenje prezentacije, bez gubljenja vizuelnog kontakta 
sa publikom.  
 
Koriste se isključivo kao podsjetnik. Prezentiranje se ne smije pretvoriti u neprekidno 
gledanje zabilješki ili čitanje istih. To ometa prezentaciju, „umrtvljuje“ izlaganje, te 
ukazuje na nedostatak samopouzdanja ili nespremnost prezentatora. 
 
Zabilješke mogu biti različite dužine –od ključnih riječi do kompletnog teksta koji 
prezentator treba izgovoriti. Preporuka je da zabilješke budu kratke, pisane u tezama. 
Zabilješke pisane u vidu punog teksta češće navode prezentatora da ih počne čitati. 
 

2.5.  Vježbanje i konačna provjera 
 
Dobro oblikovano predavanje može izgubiti na kvalitetu i biti potpuno upropašteno lošim 
nastupom. Da bi se to izbjeglo neophodno je naučiti kako prezentirati svoj rad. 
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Vještina prezentiranja se, kao i druge vještine, može naučiti. Vježbanje je sastavni dio tog 
procesa. Kontinuiranim vježbanjem i ponavljanjem vaša prezentacija će zvučati bolje, a vi 
ćete imati više samopouzdanja.  
 
I na kraju – probajte izvesti cijelu prezentaciju, imajući u vidu slijedeće savjete: 

• Probajte prezentaciju pred ogledalom ili pred drugima. 
• Probajte na mjestu održavanja prezentacije (ukoliko je moguće). 
• Probajte kao da je publika zaista prisutna. 

 
Konačna provjera podrazumijeva provjeru prostora i opreme, slajdova prezentacije i vašeg 
izgled. Obavezno dođite prije početka prezentacije, kako bi mogli izvršiti potrebne 
provjere. 
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II  KORIŠTENJE VIZUELNIH SREDSTAVA  
U IZRADI PREZENTACIJE 

 
1. Izrada prezentacije u PowerPoint-u 
 
1.1. Pokretanje PowerPoint-a 
 
Microsoft PowerPoint je dio Microsoft Office-a koji je specijaliziran za izradu prezentacija. 
Za pokretanje PowerPoint-a potrebno je da na računaru imate instaliran Microsoft 
PowerPoint6 i da poznajete osnove operativnog sistema Windows 95/98, Windows-a NT ili 
xp.  
 
Za pokretanje PowerPoint-a, slijedite ove korake: 

1. Kliknite na Start. 
2. Pomjerite pokazivač miša na All Programs. Pojavit će se izbornik programa. 
3. Pokazivačem miša kliknite na Microsoft PowerPoint. PowerPoint će se pokrenuti i 

pojavit će se uvodni prozor u kojem birate da li želite napraviti novu prezentaciju ili 
otvoriti neku od postojećih (slika 1.).  

 

 
Slika 1. 

 

1.2. Kreiranje nove prezentacije  
 
PowerPoint nudi nekoliko načina za kreiranje nove prezentacije:  

1.  AutoContent čarobnjak nudi najveću pomoć. On vas vodi kroz sve korake stvaranja 
nove prezentacije. Kad završite, imat ćete standardiziranu grupu stranica sličnog 
izgleda za određenu situaciju. Svaki šablon stranice sadrži generički tekst koji 
možete zamijeniti svojim vlastitim.  

                                                 
6 Uputstvo za izradu prezentacije u PowerPoint-u se odnosi na Microsoft PowerPoint 2002 (xp) ili Microsoft 

PowerPoint 2003 
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2.  Šablon dizajna nudi već dizajniranu boju, pozadinu i shemu fontova koji će biti 
primijenjeni na stranice koje sami izrađujete. Ne pruža vam uzorke stranica.  

3.  Možete odabrati da krenete od početka i napravite potpuno praznu prezentaciju, što 
se početnicima ne preporučuje.  

 
U ovom priručniku pažnja će biti posvećena kreiranju prezentacije na osnovu predloška 
dizajna koji nudi jednostavan put i mogućnost dodavanja vlastitih elemenata u prezentaciju. 
 

1.2.1. Korištenje šablona dizajna 
 
Šablon dizajna sadrži samo formatiranja bez slajdova. Da biste započeli novu prezentaciju 
koristeći šablon dizajna, slijedite korake: 
 

1.  Otvorite meni File i izaberite New. U desnom dijelu ekrana otvorit će se treći prozor 
PowerPoint-a, New Presentation.  

2.  U okviru tog prozora izaberite New>From Design Template. Pojavit će se tri 
kategorije šablona: Used in This Presentation (šablon u prezentaciji koju ste 
otvorili), Recently Used (nedavno korišteni šabloni) i Available For Use (šabloni 
koji su dostupni za korištenje) 

3.  Kliknite na svaki šablon kako biste pronašli onaj koji vam se dopada. Šablon koji 
izaberete će biti primijenjen u vašoj prezentaciji. Odabirom željenog šablona ste 
kreirali prvi slajd prezentacije. 

 

1.2.2. Prikazi prezentacije  
 
PowerPoint može pokazati vašu prezentaciju u različitim prikazima. Mogućnost izbora 
prikaza čini lakšim izvođenje određenih zadataka.  
 
Da biste promijenili prikaz, kliknite na View i odaberite željeni prikaz: Normal, Slide 
Sorter, Notes Page ili Slide Show. Isto možete učiniti klikom na ikonice u donjem dijelu 
lijevog prozora (slika 2.) 
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Slika 2. 

 
Normal je prikaz s 3 prozora. Njegove varijacije uključuju prikaz Outline i prikaz Slide. U 
ovom prikazu se prezentacija prvi puta otvara. 
Slide Sorter prikazuje skice svih slajdova kako biste ih lakše mogli razmjestiti. 
Notes Page pruža veliki okvir za pisanje bilježaka za vaš govor. Bilješke možete unositi i u 
prikazu Normal, no stranica za bilješke pruža vam više prostora.  
Slide Show je specijalni prikaz koji vam omogućuje pregled prezentacije na ekranu. Od 
njega ćete koristi imati tek kasnije, kad je vaša prezentacija završena. 
 

1.2.3. Uređivanje Slide Master-a 
 
Prilikom kreiranja prezentacije javlja se potreba da se pojedini elementi pojave na svim 
slajdovima, kao na primjer: naslov, datum, imena autora i sl. Pored toga, prije unošenja 
teksta i objekata u prezentaciju, može se definisati veličina, stil i boja fonta koji se će se 
primijeniti na svakom slajdu, kao i raspored objekata. Postavka takvih elemenata se vrši 
korištenjem Slide Master-a koji kontroliše ukupni izgled i postavu svakog slajda.  
 
 
Kako biste uredili Slide Master u svojoj prezentaciji, slijedite korake: 

1.  Odaberite View>Master>Slide Master (slika 3.)  
2.  Na slajdu broj 2 koji je odabran u srednjem prozoru prezentacije unesite elemente 

koji će se pojaviti na prvoj stranici (na primjer: datum, naziv fakulteta, logo …) Na 
slajdu su već ponuđena mjesta pojedinih elemenata. (slika 4.) Za dodavanje teksta 
kliknite na prostor kako biste ga označili i unesite svoj tekst. U ovom koraku ne 
pišete naziv prezentacije niti autore. 

3.  Kliknite na slajd broj 1 u lijevom prozoru i u srednji prozor unesite elemente koji će 
se pojavljivati na svim ostalim slajdovima prezentacije (na primjer: datum, naslov 
prezentacije, logo …). Pored toga možete definisati veličinu, stil i boju fonta za 
svaki od ponuđenih nivoa u kojima ćete pisati tekst.  

Prikaz prezentacije 
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4.  Kada ste završili rad sa Slide Master-om, kliknite na Close Master View u prozoru 
koji je otvoren kada ste pokrenuli Slide Master. Na ekranu će se pojaviti prvi slajd 
sa elementima koje ste postavili. 

5.  Kliknite na Insert>New Slide. Dobit ćete drugi slajd sa elementima koji će se 
pojavljivati na svakom narednom slajdu.  

 

    
               Slika 3.      Slika 4. 
 
Treba napomenuti da uz prostore za naslov i objekte, Slide Master može sadržavati i 
informacije o bojama pozadine, okvirima, brojevima stranica, clip-art objektima i bilo 
kojem drugom elementu koji želite da se pojavljuje na svim stranicama u prezentaciji. 
 
Zapamtite, kada dodate objekt na Slide Master, on će se pojavljivati na svakoj stranici. 
 

1.2.4. Upotreba Slide Layout-a 
 
Prije nego što pristupite unošenju teksta i objekata u vašu prezentaciju potrebno je upoznati 
upotrebu Slide Layout-a. Ovaj alat vam omogućava postavljanje strukture pojedinog slajda. 
Na primjer, ako na stranici želite dijagram ili sliku, možete odabrati Slide Layout koji će 
postaviti okvire za navedene elemente. 
 
Ako radije želite ručno postavljati objekte na svoju stranicu (bez okvira koje vam pruža 
Slide Layout), odaberite prazni Slide Layout kako biste kreirali praznu stranicu bez okvira. 
Zatim objekte ručno postavite na stranicu. 
 
Da biste upotrijebili Slide Layout, učinite sljedeće: 

1.  U prikazu Normal, otvorite slajd koji želite promijeniti. 
2.  Odaberite Format>Slide Layout. U desnom prozoru će se pojavit prozor za dijalog 

Slide Layout. 
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3.  Kliknite na željeni izgled slajda. PowerPoint će primijeniti odabrani izgled na 
trenutni slajd. 

 

1.2.5. Dodavanje slajdova 
 
Nakon upoznavanja sa radom Slide Layout-a, prezentaciji možete dodati još slajdova. 
Slajdove možete dodavati u prezentaciju bilo kad i na bilo koje mjesto.  
 
Da biste dodali slajd i odredili izgled, slijedite ove korake: 

1.  Odaberite slajd koji se pojavljuje prije mjesta na kojem želite dodati novi. (Slajd 
možete odabrati u bilo kojem prikazu.) 

2.  Odaberite Insert>New Slide ili pritisnite Ctrl+M. PowerPoint će dodati novi slajd. 
3.  U desnom prozoru kliknite na željeni izgled slajda.  

 

1.2.6. Dodavanje teksta na stranicu 
 
Tekst u prezentaciju unosite u predviđene okvire za naslov i okvire za unos teksta. Za 
unošenje teksta u prezentaciju kliknite na slajd u koji želite unijeti tekst, a potom na okvir 
predviđen za tekst. Okvir koji se vidi prije i prilikom unošenja teksta završetkom uređivanja 
teksta nestaje i ne vidi se kod prikaza slajdova na ekranu niti kod štampanja slajdova. Kada 
završite unos teksta, kliknite mišem izvan okvira. Ako želite, povlačite kursore za odabir 
okvira za tekst, kako biste mu promijenili veličinu. 
 
Za uređivanje teksta korisno je znati: 

• Za uređivanje samo jedne riječi kliknite dva puta na riječ. 
• Za uređivanje odlomka kliknite tri puta unutar odlomka. 
• Tekst brišete tipkama Delete i Backspace. 
• Za umetanje novog teksta, pokazivač miša postavite na mjesto na kojem želite 

umetnuti tekst, kliknite i upišite tekst. 
• Na tekstu možete koristiti opcije Cut, Copy i Paste. 
• Za uređivanje razmaka označite tekst i koristite Format>Line Spacing. 
• Za promjenu fonta i oblikovanje riječi označite tekst i koristite Format>Font.  
• Za poravnanje označite tekst i koristite Format>Alignment. 

 
Pored unosa teksta u predviđene okvire tekst na slajd možete staviti i okvire za tekst koje 
ćete sami napraviti. Da biste napravili okvir za tekst, slijedite ove korake: 

1.  Kliknite na Insert>Text Box. 
2.  Kliknite na slajd na kojem želite da se pojavi tekst. Pojavit će se mali okvir za tekst 

koji će se po potrebi proširiti, dok budete unosili tekst. 
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3.  Kad ste završili, kliknite bilo gdje izvan okvira za tekst, da biste vidjeli kako će 
tekst izgledati na završenoj stranici. 

4.  Ukoliko niste zadovoljni izgledom teksta, primijenite gore navedene savjete za 
uređenje teksta. 

 

1.2.7. Kreiranje tabele 
 
Najjednostavniji način za kreiranje tabele na stranici je upotreba Slide Layout-a u kojem je 
predviđena tabela.  
 
Koraci za kreiranje tabele su: 

1.  Promijenite slajd u takav Slide Layout (Format>Slide Layout), a zatim kliknite na 
okvir za tabelu.  

2.  Pojavit će se prozor za dijalog za kreiranje tabele u kome je potrebno izabrati broj 
redova i kolona (slika 5.).  

3.  U okvir za tekst Number of Columns izaberite broj stupaca koji želite. 
4.  U okvir za tekst Number of Rows upišite broj redova tabele. 
5.  Kliknite OK. Pojavit će se tabela koju ćete popuniti. 

 

 
Slika 5. 

 
Drugi način za dodavanje tabele je pomoću naredbe Insert>Table. Pojavit će se prozor za 
dijalog kao i u prethodnom slučaju. Ostali koraci su isti. 
 
Nakon što ste postavili tabelu na stranicu, možete na njoj raditi: 

l.  Kliknite unutar ćelije tabele i pišite. Iz ćelije u ćeliju možete se kretati pritiskom na 
Tab da biste krenuli naprijed ili Shift+Tab da biste se vratili. 

2.  Ako želite promijeniti veličinu tabele, povlačite hvataljku za odabir, kao što biste to 
učinili sa svakim objektom. 
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3.  Za prilagođavanje visine reda ili širinu stupca, postavite kursor na crtu između dva 
reda ili stupca i povlačite je u željenom smjeru. 

4.  Za promjenu okvira oko ćelija, odaberite ćeliju s kojom želite raditi i upotrijebite 
ikonice na traci s alatima za crtanje (Drawing), kako biste prilagodili debljinu, boju i 
stil mreže linija u tablici. 

 

1.2.8. Dodavanje slike iz datoteke 
 
Prilikom kreiranja prezentacije često imate potrebu da na slajd dodate sliku sa CD-a ili 
računara.  
Za dodavanje slike iz datoteke: 

1.  Izaberite slajd na koji želite postaviti sliku. 
2.  Izaberite Insert>Picture>From File. Pojavit će se prozor za dijalog Insert Picture. 
3.  Izaberite datoteku i sliku koju želite dodati.  
4.  Kliknite Insert da biste postavili sliku na slajd. Ako je slika prevelika ili premala, 

možete povlačiti kursore za odabir (male krugove) oko njezina okvira da biste 
promijenili veličinu. 

 

1.2.9. Dodavanje dijagrama  
 
PowerPoint se isporučuje s programom Microsoft Graph koji „sirove” podatke pretvara u 
dijagrame profesionalnog izgleda.  
 
Da biste napravili dijagram, slijedite ove korake: 

1.  Otvorite stranicu na koju želite dodati dijagram. 
2.  Izaberite Insert>Chart. Pojavit će se prozor za dijalog sa dijagramom i Datasheet-

om (slika 6.). 
3.  U Datasheet dodajte vlastite vrijednosti. Kliknite unutar ćelije koja sadrži ime ili 

vrijednost koju želite promijeniti i upišite šta želite. 
4.  Kliknite u sljedeću ćeliju koju želite promijeniti ili upotrijebite tipke sa strelicama 

za kretanje od ćelije do ćelije. 
5.  Ponavljajte 3. i 4. korak, dok ne unesete sve svoje podatke. Dijagram prikazuje vaše 

podatke iz datasheet-a.  
7.  Da biste izašli iz okvira za dijalog, kliknite bilo gdje izvan dijagrama. 
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Slika 6. 

 
Microsoft Graph je postavljen tako da pravi dijagrame s trodimenzionalnim prikazom.  
 
Ako želite da Microsoft Graph vaše podatke prikazuje drugačijom vrstom dijagrama, 
slijedite ove korake: 

1.  Kliknite desnim klikom na dijagram i izaberite Chart Object>Edit. Pojavit će se 
Datasheet. 

2.  Kliknite desnim klikom u ugao dijagrama i izaberite Chart Type. U prozoru Chart 
Type na lijevoj strani kliknite na željenu vrstu dijagrama a na desnoj strani kliknite 
na podvrstu. Da biste vidjeli uzorak prije nego što prihvatite dijagram, kliknite i 
držite pritisnutu tipku miša na Press and Hold to View Sample. 

3.  Kliknite OK. 
 

1.2.10. Izrada stranica s bilješkama  
 
U okviru vaše prezentacije možete napraviti bilješke koje će vam pomoći pružiti učinkovitu 
prezentaciju. 
 
Najjednostavniji način za rad na bilješkama je u prikazu Notes Page, pri čemu je svaki slajd 
podijeljen u dva dijela. Na vrhu stranice pojavljuje se umanjena verzija slajda, a ispod nje 
bilješke.  
 
Koraci za pisanje bilježaka su: 

1.  Izaberite slajd za koji želite napraviti bilješke. 
2.  Odaberite View>Notes Page da biste se prebacili u prikaz Notes Page. (slika 7.) 
3.  Kliknite u okvir Notes u donjoj polovici stranice za bilješke, kako biste ga odabrali. 
4.  Ako želite, promijenite uvećanje/smanjenje (zoom), da biste bolje vidjeli što pišete. 

Otvorite padajući popis Zoom Control na traci s alatima Standard i kliknite na 
željeni postotak.  
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5.  Upišite tekst koji želite upotrijebiti kao bilješke uz stranicu. Možete napisati 
natuknice, viceve, dodatne podatke ili objašnjenja. 

6.  Pritisnite tipku Page Up ili Page Down, da biste se pomaknuli na sljedeću stranicu 
bilježaka, a zatim ponovite 5. korak. 

7.  Ako želite, formatirajte tekst bilježaka i vratite se u prikaz Normal. 
 

 
Slika 7. 

 
Pored pisanja bilježaka u Notes Page-u, bilješke možete pisati i u prikazu Normal, u okviru 
napomena (Notes). 
 

1.2.11. Prijelazi i animacija 
 
Nakon što ste unijeli tekst i objekte, prezentaciji možete dodati vizualne efekte (prijelaze i 
animacije) koji će uljepšati prelazak s jedne stranice ili objekta na drugu i dodatno privući 
pažnju publike. 
 
Prijelaz je animacija koja pomiče prezentaciju od jednog do drugog slajda. Da biste slajdu 
dodali prijelaz, slijedite ove korake: 

1.  Kliknite na slajd kojem želite dodati prijelaz. Da biste odabrali više od jednog 
slajda, kliknite na svaki slajd držeći pritisnutu tipku Shift. Da bi ste odabrali sve 
stranice, pritisnite Ctrl+A. 

2.  Izaberite Slide Show>Slide Transition. U desnom prozoru izaberite željeni efekat 
kojeg ćete odmah vidjeti na slajdu u srednjem prozoru, ukoliko je izabrana opcija 
AutoPreview na dnu lijevog prozora.  

3.  Na dnu desnog prozora u dijelu Modify Transition izaberite željenu brzinu prijelaza 
(Speed) i/ili zvuk (Sound). 

4.  Ukoliko niste izabrali sve slajdove, klikom na Apply to All izabrani prijelaz možete 
pridružiti svim slajdovima u prezentaciji. 

 



   21

Pored prijelaza koji djeluju na cijeli slajd, pojedinim elementima možete pridružiti efekte. 
Na primjer, možda želite da se prvo pojavljuje pozadina i naslov (upotrebom prijelaza), a 
potom, jedna po jedna, stavka popisa ispod naslova. 
 
Najjednostavniji oblik animacije je animiranje teksta na slajdu, odvojeno od njegova 
naslova ili pozadine. Kad odaberete neki od ovih efekata, naslov i pozadina pojavit će se 
onako kako su određeni prijelazom, a zatim će se pojaviti ostatak teksta na slajdu, odlomak 
po odlomak, uz odabrani efekt. 
 
Da biste nekom objektu na slajdu pridružili jednostavne animacijske efekte, slijedite ove 
korake: 

1.  Izaberite slajd s tekstom koji želite animirati. Kliknite na tekst. 
2.  Izaberite Slide Show>Animation i u desnom prozoru odaberite animacijski efekt za 

tekst na toj stranici. 
3.  Prebacite se u prikaz Slide Show, kako biste pregledali efekt.  
4.  Pritisnite tipku Page Down ili kliknite tipkom miša. Pojavit će se prvi odlomak uz 

odabrani efekt. 
5.  Nastavite pritiskati Page Down ili klikati, dok se sav tekst ne pojavi na zaslonu. 
6.  Pritisnite Esc (Escape) da biste se vratili u prikaz Normal. 

 

1.2.12. Prikaz prezentacije na ekranu računara 
 
Nakon što unesete sve elemente provjerite na svom računaru, izgled i funkcionalnost 
prezentacije. Da biste pregledali prezentaciju, slijedite ove korake: 

1.  Otvorite prezentaciju koju želite vidjeti. 
2.  Izaberite Slide Show>View Show ili pritisnite F5. Prvi slajd prezentacije pojavit će 

se na cijelom ekranu. 
3.  Za prikaz sljedećeg ili prethodnog slajda, učinite sljedeće: 

 –  Da biste prikazali sljedeći slajd, kliknite lijevom tipkom miša, pritisnite tipku 
Page Down ili pritisnite tipku sa strelicom udesno, odnosno prema dolje. 

 –  Da biste prikazali prethodnu stranicu, kliknite desnom tipkom miša, pritisnite 
tipku Page Up ili pritisnite tipku sa strelicom ulijevo, odnosno prema gore. 

4.  Za završetak prikaza prezentacije, pritisnite tipku Esc. 
 

1.2.13. Izrada „Handouts” 
 
Ukoliko ste zadovoljni izgledom prezentacije možete pristupiti i izradi letaka za publiku - 
tzv. „Handouts”. To ćete učiniti štampanjem prezentacije po nekoliko stranica na jednoj 
stranici papira. „Handouts”-i publici omogućavaju da prate predavača i da zabilježi 
komentare.  
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Za izradu „Handouts” slijedite korake: 
1.  Izaberite File>Print. Otvorit će se prozor za dijalog Print. 
2.  Izaberite Printer. 
3.  Otvorite padajući popis Print What i odaberite Handouts.  
4.  U okviru Handouts otvorite padajući popis Slides Per Page i odaberite 2, 3, 4, 6 ili 9 

stranica po stranici papira i Order. (slika 8.) 
5.  U okviru za dijalog Print odredite ostale parametre, poput Number of Copies (broj 

kopija). 
6.  Kliknite OK za ispis.  

 

 
Slika 8. 

 

2. Tehnička podrška za prezentaciju 

Tehničkom podrškom smatra se sva oprema koja pomaže da publici slikom i/ili zvukom 
predstavite svoju prezentaciju. U zavisnosti od vrste prezentacije možete birati različita 
pomagala. Pri tome je jako bitno da znate koristiti opremu koju ste izabrali. Prije početka 
prezentacije obavezno provjerite opremu, kako ne biste ostali zatečeni njenim 
otkazivanjem. Ukoliko se desi i takva situacija, pokušajte biti opušteni i slušaocima 
ispričati nešto zanimljivo, kako biste izbjegli neugodnu tišinu. 
 
Mikrofon  

Mikrofon je obavezan dio opreme, ukoliko prezentaciju vršite u velikim prostorijama i pred 
velikim brojem slušalaca. Najbolje je koristiti bežični mikrofon koji će vam omogućiti 
slobodno kretanje i lakše korištenje ostale opreme.  
Prilikom pripreme opreme posebnu pažnju obratite na slijedeće: 

• Jačina razglasa treba biti u skladu sa veličinom prostorije - slušaoci u zadnjem redu 
vas moraju dobro čuti. 

• Mikrofon ne smije praviti šumove. 
• Odredite optimalnu udaljenost između usta i mikrofona. 
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Kreda i tabla 
 
Tabla je vrlo statično sredstvo za prezentaciju koje se može koristiti za predstavljanje teksta 
ili jednostavnijih prikaza. Zbog toga je tablu najbolje koristiti kao pomoćno sredstvo na 
kojem ćete dodatno objasniti ono što je predstavljeno na projekciji prezentacije.  
 
Pored školske table u upotrebi je i mobilna tabla od papira. Samoljepljive listove papira sa 
table možete postaviti i na zid prostorije poput velikih «post-it» listića.  
 
Prilikom korištenja ove vrste pomagala obezbijedite dovoljan broj kreda i flomastera u 
različitim bojama. 
 
Grafoskop 
 
Grafoskop omogućava projekciju slika i teksta sa prozirnih folija na zid ili projekcijsko 
platno. Posebnu pažnju treba obratiti na pripremu folija vodeći računa o vizuelnom dojmu i 
vidljivosti teksta na zidu. Prilikom prezentacije folije trebaju biti poredane po redoslijedu, 
kako ne biste gubili vrijeme na pronalaženje odgovarajuće folije. 
 
Projektor  
 
Projektor omogućava multimedijalnu prezentaciju sastavljenu od teskta, grafike, animacije i 
zvuka, koja se može prikazati sa računara. Prednost korištenja ovog uređaja je mogućnost 
kombinovanja govora prezentatora s nekoliko medija, a time i mogućnost promjene ritma 
prezentacije, čime se održava stalna pažnja publike. Prilikom upotrebe projektora obavezno 
provjerite: 

• da se prezentacija može pokrenuti na računaru; 
• da se na zidu ili platnu ne stvara izobličena slika; 
• da svi mogu jasno vidjeti sliku; ako je potrebno zamračite prostoriju ili promijenite 

podlogu prezentacije; 
• da imate zvučnike, ukoliko prezentacija sadrži zvuk. 

 
Ukoliko imate potrebu da se krećete tokom prezentacije, koristite uređaj za daljinsku 
promjenu slajdova na prezentaciji ili zamolite nekoga da na vaš diskretan znak mijenja 
slajdove. 
  
Pokazivač 
 
Prilikom korištenja grafoskopa ili projektora često se javlja potreba naglašavanja pojedinih 
detalja prezentacije. Najbolje sredstvo za pokazivanje je uređaj sa laserskom crvenom 
tačkom. Međutim, ako vam ruke u toku prezentacije drhte od treme, ne preporučuje se 
korištenje ovog pomagala. 
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III KREIRANJE SLAJDOVA ZA POWERPOINT PREZENTACIJU 
 
1. Osnovne smjernice za pripremanje uspješne  
PowerPoint prezentacije 
 
Cilj ovog dijela priručnika jeste da uz pomoć savjeta i uputa koje ćemo vam dati u nastavku 
teksta, izbjegnete pogrešne korake u pripremi elektronske PowerPoint prezentacije (u 
daljnjem tekst «ppt»). Prije pristupanja samoj izradi PowerPoint prezentacije 
podrazumijeva se da ste već obavili početne pripreme za kreiranje iste. To znači da ste 
pažljivo isplanirali vašu prezentaciju, da poznajete svoju publiku, da ste uvježbali izvođenje 
prezentacije, te da govorite «jasno i glasno». Pri pripremanju i planiranju prezentacije, 
trebate obratiti pažnju na strukturu prezentacije, tj. da sadrži početak, sredinu i kraj. 
Prezentacija se sastoji od početnog slajda, te slajda koji sadrži ciljeve ili plan prezentacije. 
Zaključite prezentaciju rezimirajući činjenice i važne informacije koje ste prezentirali. Na 
samom kraju prezentacije, potrebno je navesti korištene izvore informacija. 
 
 

1.1. Početni slajd prezentacije 
 
Početni slajd PowerPoint prezentacije treba 
sadržavati naslov prezentacije, instituciju 
ispred koje se vrši prezentacija, vaše ime i 
prezime, te datum i mjesto prezentiranja. Na 
prvom ili posljednjem slajdu trebate navesti 
i svoje kontakt informacije.  
 

      
         Slika 9. 

1.2. Količina teksta na slajdu 
 
Budući da PowerPoint koristite kao podršku usmenom prezentiranju, veoma je važno da na 
slajdove ne stavljate previše teksta. Ponavljanja i deskriptivni opisi će nepotrebno opteretiti 
slajdove vaše prezentacije. Obrišite nepotrebne riječi i fraze ili ih skratite, eliminišite 
nebitno i uključite samo one važne, neophodne informacije. Ukoliko se na slajdu nalazi 
previše teksta auditorij će se vjerovatno više koncentrirati na čitanje slajda, nego na 
slušanje vašeg izlaganja.  
 
Slajdove je teško čitati, ukoliko je na njima previše teksta. Pomozite vašem auditoriju 
stavljajući na slajdove samo važne i „lako pamtljive“ informacije.  
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U okviru jednog slajda preporučuje se korištenje pravila «6-6-6» koje glasi: 
• ne više od šest riječi u jednoj alineji; 
• ne više od šest alineja po jednom slajdu; 
• ne više od šest tekstualnih linija po slajdu. 

 

    
        Slika 10.                 Slika 11. 

 

1.3. Korištenje fontova na slajdu 
 
Prekomjerna upotreba različitih vrsta slova može odvratiti pažnju auditorija i unijeti 
elemente nedosljednosti u prezentaciju. Jednostavnije je pratiti izlaganu temu ukoliko u 
prezentaciji dosljedno koristite istu vrstu slova i ukoliko pažnju auditorija ne odvlače 
različiti dekorativni fontovi.  
 
Preporučuje se korištenje Sans Sarif slova (poput Arial ili Verdana), jer ih je lakše čitati na 
ekranu. Za pravljenje «handouts» preporučuje se korištenje Times New Roman fonta, jer je 
najjednostavniji i najbolji font za čitanje sa pisanih materijala. Dosljednost u upotrebi jedne 
vrste slova čini prezentaciju profesionalnijom i lakšom za praćenje. Ukoliko želite 
upotrijebiti i neki dodatni font, preporuka je da to maksimalno budu tri različita fonta u 
okviru jedne PowerPoint prezentacije. 
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     Slika 12.      Slika 13. 
 

1.4. Veličina slova na slajdu 
 
Pri kreiranju morate posvetiti pažnju veličini slova koju koristite u prezentaciji. Ukoliko su 
slova manja od tipa 24, auditoriju će biti teško pročitati sadržaj slajda. Predložene veličine 
slova u prezentacijama variraju od 24 do 32, vodeći računa o dosljednosti u cijeloj 
prezentaciji. Preporučuje se da izbjegavate korištenje italik slova, jer ih je teško čitati. 
Možete koristiti podebljana (boldirana) slova, ukoliko želite nešto naglasiti. Izbjegavajte 
upotrebu skraćenica. 
 

    
       Slika 14.      Slika 15. 
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1.5. Upotreba velikih (CAPS) slova na slajdu 
 
Kod pripreme slajdova, trebate uzeti u obzir i činjenicu da će auditorij morati ponovno 
pročitati tekst, ukoliko se u njemu nalazi više od sedam riječi koje su napisane velikim 
slovima. Napisane velikim slovima riječi će djelovati «zbijeno». Velika slova se koriste 
unutar slajda samo ukoliko želite istaći neke podatke ili informacije koje su VEOMA 
važne7. Stoga se preporučuje korištenje velikih i malih slova u naslovima kako bi se 
izbjegla samo VELIKA SLOVA. Time auditoriju olakšavate praćenje sadržaja. 
 

    
       Slika 16.                Slika 17. 
 
1.6. Animacije i prijelaz teksta 
 
Pri pripremi slajdova savjetujemo korištenje iste vrste animacije i prijelaza teksta u cijeloj 
prezentaciji. Korištenje različitih animacija i prijelaza teksta može uticati na pažnju 
auditorija i odvratiti ih od slušanja prezentacije. Prezentacije poput ove neće izgledati 
profesionalno. Ukoliko koristite jednu istu animaciju kroz cijelu ppt prezentaciju pomažete 
auditoriju pri koncentriranju na sam sadržaj. Ovaj oblik animacije je najpogodniji ukoliko 
ne želite otkrivati sve informacije sa slajda odjednom. Time auditoriju ostavljate dovoljno 
vremena za razumijevanje i usvajanje ciljanih informacija. 

                                                 
7 Elizabeth Hanlis, Efikasne prezentacije, Predavanja u okviru Projekta „Inicijativa za usavršavanje nastavnog 

osoblja I“, Prevod, (Edmonton: University of Alberta, oktobar 2005.) 
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     Slika 18.                Slika 19. 
 
 

1.7. Upotreba vizuelnih sredstava na slajdu: slike, fotografije i karikature 
 
Vizuelna sredstva obično pojednostavljuju prezentaciju, naglašavaju i sumiraju dijelove, te 
poboljšavaju razumijevanje. Vizualizacija informacija je važna u kreiranju PowerPoint 
prezentacije. Pravilnim odabirom informacija, te održavanjem balansa između ilustracija i 
riječi8, pomažete kreiranju profesionalnog izgleda prezentacije. Slike su efektivan način 
komunikacije sa auditorijem i ljudi ih duže pamte. Ipak, ukoliko vizuelna sredstva ne 
podržavaju osnovnu poruku, onda njihovo korištenje nije opravdano9. Vizuelna sredstva 
možete koristiti kao dopunu pisanoj riječi i upotrebljavati ih u slučaju kada želite nešto 
naglasiti. Slike trebaju biti dovoljno velike da ne ometaju čitanje teksta i brojeva. Međutim, 
ukoliko se vaša prezentacija sastoji od većeg broja slajdova (30 i više), auditoriju će s 
vremena na vrijeme trebati i kratki predah. U takvom slučaju možete koristiti fotografije, 
karikature ili slike, kao osnovu kratke diskusije ili odmora nakon tematskih blokova u 
trajanju od 15-20 minuta. 

                                                 
8 Besim Ćulahović i Almir Peštek, Uspješna prezentacija: Handouts. TEMPUS projekt: JEP-17022-2002. 

(Sarajevo: Tempus, 2004.) 
9 Ibidem, p. 25. 
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        Slika 20.      Slika 21. 
 

1.7.1. Upotreba vizuelnih sredstava na slajdu: grafikoni 
 
Vrste ponuđenih grafikona u PowerPoint-u su: 

• Tabele - Tables 
• Dijagram sa linijama ili stupcima (histogram) - Bar charts 
• Pita dijagram ili dijagram površina - Pie charts 
• Dijagram sa stupcima - Line charts 
• Dijagrami tokova - Flow charts 
• Mape - Maps 
• Skice - Drawings  
• Organizacioni dijagrami - Organizations charts  
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Slika 22. 
 
Grafikoni moraju biti dovoljno veliki i naglašeni. Na jedan slajd nemojte stavljati više od 
dva grafikona. Ukoliko koristite mnogo grafikona, auditorij će biti suviše koncentriran na 
njih, a vašem predavanju neće posvećivati dovoljno pažnje. Također ne treba koristiti 
grafikone koji nisu direktno povezani sa temom koju izlažete. Na slajd uvrstite grafikone 
koji su direktno vezani za predstavljeni sadržaj.  
 
Tabele se obično koriste za prezentiranje detaljnih i tačnih vrijednosti, dijagram sa linijama 
ili stupcima za ilustraciju npr. vremenskih trendova, pita dijagram za učestalost ili 
distribuciju, dijagram sa stupcima – za kompariranje podataka i dijagram toka za 
prikazivanje procesa ili procedura.10 
 
 

                                                 
10 Ibidem, p. 27 

 Tabele - Tables 
  

   
   

 Dijagram sa linijama ili stupcima 
(histogram) - Bar charts 

 
 
 
 

 Pita dijagram ili dijagram 
površina - Pie charts 

 
 
 
 

 Dijagram sa linijama - Line 
charts 

 Dijagram toka - Flow charts 
 
 
 
 
 

 Mape – Maps 

 Skice - Drawings  Organizacioni dijagrami - 
Organizations charts 
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1.8. Boja pozadine i slova 
 
Pri korištenju PowerPointa, trebate voditi računa o upotrebi jakog kontrasta između boje 
pozadine i boje slova, koristeći ili tamna slova na svijetloj pozadini ili svijetla slova na 
tamnoj pozadini. Najbolje kombinacije su: bijela ili bež pozadina sa crnim ili tamnoplavim 
slovima, ili tamnoplava pozadina sa bijelom ili bež slovima. 
 

    
     Slika 23.                 Slika 24. 

 

1.9. Korištenje gotovih uzoraka 
 
Trudeći se da prezentaciju učinite „originalnom“ i „drugačijom“, često se dešava da sa 
Interneta preuzimate različite šablone gotovog dizajna slajdova. Ukoliko koristite gotove 
dizajnirane slajdove sa Interneta, moguće su greške. Ovi slajdovi možda dobro izgledaju na 
vašem kućnom kompjuteru, ali ne i projicirani na velikom ekranu. Ukoliko koristite šablon 
dizajn PowerPointa, tu je najmanja mogućnost greške. Šabloni prezentaciji daju dosljedan 
izgled i čine je profesionalnijom.  
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       Slika 25.                Slika 26. 
 
 
2. Kratka lista korisnih savjeta za izradu slajdova 

 
Na kraju, da ponovimo savjete koji vam mogu pomoći u pripremi efikasne, profesionalne i 
dobre prezentacije.  

• Zapamtite i koristite pravilo 6-6-6. 
• Budite dosljedni u korištenju vrste slova. 
• Koristite veličinu slova od 24 do 32 pt. 
• Izbjegavajte korištenje italik slova, jer ih je teško čitati. 
• Koristite bold (podebljana) slova ukoliko nešto želite naglasiti. 
• Izbjegnite kontinuirano korištenje VELIKIH SLOVA. 
• Koristite dosljednu animaciju i prijelaz teksta. 
• Koristite vizuelna sredstva i zvučne tonove (slike, fotografije, muzika i sl.) koje se 

odnose na i pospješuju sadržaj teme11. 
• Koristite jak kontrast između boje pozadine i boje teksta. 
• Koristite gotove šablone/ uzorke/ paterne u PowerPointu. 

 
U pogledu dužine prezentacije, predlažemo korištenje 5-7 slajdova za 15-minutnu efikasnu 
prezentaciju. Predavanje od 45 minuta treba biti podržano prezentacijom sa najviše 15-25 
slajdova. Međutim, to uveliko ovisi od sadržaja i strukture vaše prezentacije.  
 
 

                                                 
11 Andrew Leigh i Michael Maynard, Savršena prezentacija: Put i način da uspete od prve, Prevod., 

(Beograd: Javno preduzeće „Službeni glasnik“ i Institut za ekonomiku i finansije, n.a.), p. 44. 
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IV  VJEŠTINA PREZENTIRANJA 
 
1. Osnovni elementi prezentacije 
 
Osnovni elementi prezentacije su: 

• publika/auditorij 
• vrijeme 
• prostor 
• vizuelna sredstva 
• prezentator 

 

1.1. Publika 
 
Upoznati publiku znači znati broj učesnika koji će prisustvovati predavanju, sastav/ profil 
publike, prosječan nivo znanja publike o tematici prezentacije. Izlaganje se mora prilagoditi 
osobinama auditorija – njihovom znanju, iskustvu, interesima i dr. Ukoliko publika nije 
upoznata sa osnovama izlagane teme, počnite sa objašnjavanjem osnovnih pojmova. U 
slučaju da auditorij posjeduje izvjesno predznanje o temi, podsjetite ih na osnovne pojmove 
i definicije postavljanjem pitanja. 
 
Nakon prikupljanja informacija o publici, morate se staviti u ulogu «slušatelja» – uspjeh 
prezentacije zavisi i od toga u kojoj ste mjeri uzeli u obzir perspektivu slušalaca. 
 
Kada poznajete auditorij, npr. kada prezentujete pred svojim kolegama, izlaganje može biti 
manje formalno. 
(Preporučujemo da više o upoznavanju publike pročitate u knjizi Michaela Gelba „Predstavite sebe: Kako 
osmisliti i održati upečatljive i nezaboravne prezentacije“ Beograd: FINESA, 2003., p. 34.) 
 

1.2. Vrijeme 
 
Vrijeme prezentacije odnosi se na termin održavanja i trajanje prezentacije.  
 
Prezentaciju morate početi na vrijeme. Kašnjenje predstavlja „loš početak“ i stvara 
negativan prvi utisak.  
 
Morate znati koliko prezentacija može trajati, te da li ste jedini govornik ili jedan od 
mnogih. No, bez obzira koliko vremena imate za prezentaciju, najbitnije je efektivno 
iskoristiti to vrijeme, što znači držati se ove jednostavne formule12: 

                                                 
12 Mary Jo Kmetz, Kako govoriti sa samopouzdanjem, Predavanje, (Sarajevo: Ekonomski fakultet u Sarajevu i 

University of Delaware, januar 2006.) 
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• 80-85% vremena posvetiti glavnim tačkama prezentacije, 
• preostalih 15-20% vremena podijeliti između uvoda i zaključka. 

 
I na kraju – završite prezentaciju na vrijeme! 
 

1.3. Prostor 
 
Od prostornih uslova umnogome zavisi kako će prezentacija biti organizovana. Prostorne 
uslove čine: oblik i veličina prostorije, uređenje prostorije, razmještaj sjedišta, akustika, 
osvjetljenje, temperatura, tehnička sredstva13. 
 
Za prezentatora je značajno da se upozna sa prostorom u kojem će držati prezentaciju, a 
posebno ako je u prilici da vježba na tom mjestu.  
U pogledu tehničkih sredstava bitno je da li su instalirana sva sredstva koja su vam 
potrebna, da li su ispravna, da li su razmještena na odgovarajući način. Na primjer, 
preskakanje kompjuterskog kabla svaki put kada želite nešto pokazati ili prići publici, 
vjerovatno će uveseljavati publiku, pogotovo ako preskakanje koji put bude neuspješno, ali 
imajte na umu da to nije svrha vaše prezentacije. Prije početka prezentacije neophodno je 
provjeriti ispravnost i razmještaj tehničkih sredstava. 
 
Razmještaj sjedišta i tehničke opreme treba omogućiti: 

• udoban smještaj publike; 
• nesmetano kretanje prezentatora; 
• svi vide prezentatora i slajdove/ vizuelna pomagala koja koristite; 
• svi čuju šta govorite tokom prezentacije. 

 
Za manje grupe (do 25 osoba) preporučuje se tzv. „U“ oblik razmještaja sjedišta, a za veće 
grupe klasičan oblik razmještaja karakterističan za učionice. 
 
Što se tiče rasvjete, najbolje je prirodno odnosno električno osvjetljenje. U pogledu 
vazduha i temperature, neophodno je da prostorija bude dobro provjetrena sa umjerenom 
temperaturom. 
 
Savjeti: 

• Posjetite prostoriju za prezentaciju bar dan ranije i ponovo bar pola sata prije 
početka prezentacije. 

• Provjerite vidljivost i akustičnost sjedeći na raznim mjestima u sali. 
• Nastojte prilagoditi okruženje: razmještaj, osvjetljenje, temperaturu, ventilaciju. 

                                                 
13  O vizuelnim sredstvima ćemo u nastavku posebno pisati, budući da se radi o veoma značajnom elementu 

uspjeha prezentacije. 
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• Po mogućnosti, učinite prostor zanimljivijim i «toplijim» (natpis „dobrodošli“ na 
flip-chartu, citati po zidovima, ilustracije, plakati...). 

 

1.4. Vizuelna sredstva 
 
„Jedna slika govori više nego hiljadu riječi.“ (kineska narodna izreka) 
 
Vizuelna sredstva omogućavaju zadržavanje pažnje i veće uključivanje publike, te lakše 
razumijevanje i usvajanje informacija. Prema jednom istraživanju, upotreba vizuelnih 
sredstava čini prezentaciju za 50% lakšom za pamćenje, a vašu poruku za 43% 
uvjerljivijom.14 

 
PowerPoint koji je u ovom priručniku detaljnije opisan, budući da je danas najčešće 
korišteno sredstvo za akademske prezentacije, može se kombinovati i sa drugim 
pomagalima, kao što su: tabla za prezentaciju (flip chart), video zapis (video clip), prateći 
odštampani materijali (handouts) i dr. 
 
Kada se vizuelna sredstva koriste ispravno i u razumnoj mjeri, ona pojačavaju upečatljivost 
prezentacije. Treba imati na umu da su vizuelna sredstva ipak samo pomoćna sredstva, da 
prezentator treba da dominira prezentacijom, a ne tehnika. Neophodno je postići balans 
između slika i riječi. Pored toga, korištenje sredstava za prezentaciju treba da bude u 
funkciji poboljšanja prezentacije, a ne izdvojeni događaj. 
 
Savjeti u korištenju vizuelnih sredstava: 

• Ne koristite sredstva samo zato što ih svi koriste, jer je to «privlačno» i „moderno“. 
• Koristite sredstva koja odgovaraju vašoj poruci i situaciji (raspoloživom prostoru, 

vremenu, publici). 
• Pretpostavite da neka od sredstava mogu biti neispravna i pripremite se za takav 

slučaj. 
 
Zapamtite: 

Vizuelno sredstvo je odgovarajuće jedino ako poboljšava prezentaciju pojačavajući vašu 
poruku. 
 
 

                                                 
14 Elizabeth Hanlis, Efikasne prezentacije, Predavanja u okviru Projekta „Inicijativa za usavršavanje 

nastavnog osoblja II“, Prevod, (Edmonton: University of Alberta, juni 2006.) 
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1.5. Prezentator 
 
Osobine koje posjeduje dobar prezentator, od kojih bitno zavisi uspjeh prezentacije su 
slijedeće: 

• integritet – publika vjeruje prezentatoru, 
• znanje – prezentator posjeduje odgovarajuće stručno znanje o datoj temi, 
• govorničke sposobnosti, 
• samouvjerenost (ali ne arogantnost), 
• smirenost. 

 
Evo nekoliko savjeta šta treba, a šta ne treba raditi u odnosu sa publikom. 
 
Šta treba raditi? 

• „Povežite“ se s publikom: pokažite entuzijazam, izgledajte prijateljski, smiješite se, 
gestikulirajte.  

• Budite ljubazni, ali izbjegavajte intimno obraćanje. 
• Ako poznajete publiku, oslovljavajte slušaoce imenom pri pojedinačnom obraćanju. 
• Pažljivo slušajte ono što vam publika govori. 
• Prilagodite svoj stil slušaocima. 
• Podstičite diskusiju, sumirajte, ponavljajte. 
• Budite etični u odnosu prema publici. 
• Uvijek naglašavajte pozitivno. 
 

Šta ne treba raditi? 
• Izbjegavajte duga objašnjenja. 
• Izbjegavajte propovijedi i hvalisanje. 
• Ne provocirajte i ne budite arogantni. 
• Oprezno koristite žargon. 

 
U prezentaciju treba u određenoj mjeri unijeti svoje emocije. Dobra prezentacija je ona koja 
«pokreće» publiku. Takva prezentacija podstiče, izaziva, uzbuđuje, zabavlja publiku. Zato 
nastojte ispoljavati i svoja osjećanja prema temi o kojoj govorite. Imajte na umu da „ljude 
pokreću osjećanja, a ne činjenice“15. Veoma je bitno je i da vjerujete u ono što govorite. 
 
 

                                                 
15 Andrew Leigh i Michael Maynard, Savršena prezentacija: Put i način da uspete od prve, Prevod., 

(Beograd: Javno preduzeće „Službeni glasnik“ i Institut za ekonomiku i finansije, n.a.), p. 88. 
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2. Verbalna i neverbalna komunikacija 
 
Prezentacija kao poseban oblik komunikacije ima svoje verbalne i neverbalne komponente. 
Pri tome imajte na umu jednu veoma važnu stvar: 
 
Verbalno izlaganje i govor tijela moraju biti usklađeni – moraju prenositi istu poruku. 
 
„Ako govor Vašeg tela nije sinhronizovan s Vašom porukom, gubite kredibilitet.“16 
 

2.1. Verbalne komponente komunikacije 
 
Verbalne komponente podrazumijevaju komunikaciju riječima i glasom. Za uspješnu 
prezentaciju neophodna je ispravna upotreba riječi i odgovarajući govor. 
 
Ispravna upotreba riječi podrazumijeva: 

• pravilan i gramatički ispravan pisani i govorni jezik, 
• sistematičnost, 
• jasnoća, 
• jednostavnost, 
• koherentnost (logička povezanost), 
• ponavljanje (potvrđivanje i jačanje tvrdnje). 
 

Žargon treba koristiti vrlo oprezno i samo izuzetno. Neformalno obraćanje koje je obično 
prisutno ako poznajemo publiku, ne znači i korištenje žargona. 
 
Kod govora su bitne slijedeće osobine: 

• razumljivost, 
• glasnoća, 
• brzina, 
• ritam. 

 
Glas ne smije biti jednoličan, ali treba izbjegavati nagle promjene – treba držati ujednačenu 
snagu i ritam glasa. Izuzetno se može koristiti povišen ton, ako želite naglasiti pojedine 
riječi ili rečenice. 
 

                                                 
16 Michael Gelb, Predstavite sebe: Kako osmisliti i održati upečatljive i nezaboravne prezentacije, (Beograd: 

FINESA, 2003.), p. 84. 
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Nastojte držati umjeren tempo izlaganja tokom najvećeg dijela prezentacije. Suviše sporo 
ili suviše brzo izlaganje prije ili kasnije dovode do slabljenja pažnje slušalaca i umanjuju 
kvalitetu prezentacije. Ako govorite suviše sporo, izlaganje postaje monotono. Usporite 
izlaganje jedino kada iznosite određene statističke podatke i brojeve, pokazujete slike, 
tabele, grafike ili sl. Kada govorite suviše brzo, publika će imati problema da razumije i 
usvoji ono o čemu govorite. Nemojte se brzo prebacivati sa slajda na slajd, jer to djeluje 
frustrirajuće na publiku i nakon nekog vremena slabi pažnju slušalaca. Slušaocima treba 
dati vremena da uoče i razumiju šta se nalazi na slajdu. Preporučljivo je praviti pauze 
tokom izlaganja, ali nemojte praviti duge pauze između riječi ili rečenica. 
 
Govor ne bi smio biti: 

• loše artikulisan, 
• nerazgovijetan, 
• tih, 
• prebrz ili prespor, 
• jednoličan, 
• «izvještačenog» tona. 

 
 
2.2. Neverbalne komponente komunikacije („Govor tijela“) 
 
Neverbalno komuniciranje je komuniciranje bez upotrebe riječi. To je najstariji oblik 
komunikacije. Neverbalno komuniciranje je ograničeno kulturološkim razlikama i stoga 
treba znati kada i kako se koristi, jer može biti dvosmisleno. Neverbalno komuniciranje 
treba podržavati verbalnu poruku. 
 
Neverbalne komponente komuniciranja uključuju: 

• izgled, 
• upotrebu prostora, 
• pokrete / gestove, 
• vizuelni kontakt – izraz lica i kontakt očima. 

 
Izgled: 
 

• Izgledajte najbolje što možete, u skladu sa događajem (prilikom).  
• Zadržite svoj stil odijevanja i nemojte za prezentaciju odjenuti nešto što nikada 

ranije niste i ne biste obukli i u čemu ćete se cijelo vrijeme osjećati neugodno. 
• Budite čisti, uredni i odjeveni u skladne boje. 
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Upotreba prostora: 
 
Pravilno koristiti prostor znači znati kako i gdje stajati, kako i kuda se kretati, kako držati 
tijelo. 
 
Tokom prezentacije prezentator se kreće ili stoji. Rijetki su slučajevi da prezentator sjedi 
tokom izlaganja.  
 
Kada stojite, pridržavajte se slijedećih pravila: 

• Nemojte stajati iza govornice; trebate stajati sa lijeve strane ekrana.  
• Nemojte stajati «pogureno» niti ukočeno; stojte uspravno, ali opušteno. 
• Ne ljuljajte se dok stojite; stojte mirno. 
• Ne oslanjajte se rukama i sa ravnim položajem ramena na sto, jer to može djelovati 

prijeteći.  
 

Ako se krećete tokom prezentacije, zapamtite ove savjete: 
• Ne «premjeravajte» podij koracima tamo-ovamo. 
• Krećite se polako u ograničenom prostoru. 
• Ne okrećite leđa publici. 
• Izbjegavajte naglu promjenu smjera kretanja i nagle pokrete. 

 
Kretanje trebate ograničiti na trougao prikazan na slici17: 
 

 
Slika 27: Pozicija prezentatora 

 
Kada želite nešto naglasiti, približite se publici. Ukoliko želite nešto pokazati na ekranu, 
približite se ekranu, ne okrećući leđa publici. 
 
                                                 
17  Elizabeth Hanlis, Efikasne prezentacije, Predavanja u okviru Projekta „Inicijativa za usavršavanje 

nastavnog osoblja II“, Prevod, (Edmonton: University of Alberta, juni 2006.) 

EKRAN 

SLUŠAOCI 
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Pokreti / gestovi: 
 
Izbjegavajte držanje ruku u džepovima – radije gestikulirajte. Gestikuliranje rukama tokom 
prezentacije je sasvim normalna pojava. Ipak, nemojte nekontrolisano «mahati» rukama 
tokom prezentacije. Gestovi moraju biti prirodni, živahni, svrsishodni, izražajni i jasni. 
Izbjegavajte nepotrebne gestove kakvi su, na primjer, igranje olovkom, «lomljenje prstiju», 
uvrtanje pramena kose i slično. 
 
Ukoliko ne želite gestikulirati, onda možete ruke držati opuštene pored tijela ili, ako imate 
tremu, možete u rukama držati neki predmet (olovku, pokazivač, zabilješke i sl.), ali se 
nemojte igrati sa njim. 
 
Vizuelni kontakt: 
 
Nemojte stalno gledati u zabilješke ili u pod ili pogledom „krečiti“ zidove prostorije. 
Gledajte u publiku. Preporučuje se najmanje 80% od vremena trajanja prezentacije 
održavati vizuelni kontakt (kontakt očima) sa publikom. Pri tome imajte na umu da publika 
nije bezoblična masa. Nastojte da sretnete pogled prisutnih i da tako privučete njihovu 
pažnju. 
 
Takođe trebate izbjegavati usmjeravanje pogleda prema jednoj strani prostorije, već 
gledajte podjednako sa obje strane i u sredinu prostorije. Ako je u pitanju amfiteatar, držite 
pogled u visini središnjih redova. 
 
Najbolje je pronaći u publici lica koja izgledaju prijateljski i zainteresovano i gledati u 
njihovom pravcu. Nemojte gledati prisutne ravno u oči, već u područje između očiju ili u 
čelo. Vodite računa pri tome da ne zadržavate dugo pogled na pojedincima, jer bi to moglo 
uznemiriti slušaoce i omesti vašu koncentraciju. 
 
Kada želite pokazati nešto na ekranu, vaš pogled treba slijediti pokret ruke ili pokazivača. 
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3. Kako pobijediti tremu? 
 
„Svako ima leptiriće u stomaku – samo što kod profesionalca oni lete organizovano.“18 
 
Svako, pa i najiskusniji prezentator, osjeća tremu prije početka predavanja. Najpouzdaniji 
način prevazilaženja početne treme, jeste vježba i ponavljanje prezentacije, jer na taj način 
podižete svoje samopouzdanje. 
 
Evo nekoliko dodatnih savjeta kako da pokušate prevazići tremu: 

• Zapamtite što više teksta! (Posebno je bitno zapamtiti uvod i zaključak – to podiže 
samopouzdanje i ujedno impresionira publiku.) 

• Vježbajte što više, pogotovo početak prezentacije! 
• Provjerite sve prije početka: prostor, tehniku, svoje slajdove i zabilješke, svoj 

izgled! 
• Mislite pozitivno – zamišljajte uspjeh! 
• Ne doživljavajte publiku kao protivnika! 
• Koncentrišite se na sadržaj prezentacije, na ono što želite reći, a ne na sebe niti na 

publiku! 
• Ne žurite i ne paničite! 
• U rukama držite olovku, zabilješke, pokazivač ili nešto slično, da izbjegnete da vam 

se od treme tresu ruke! 
 
Jedan od načina da pobijedite tremu jeste da na samom početku date publici da nešto radi, 
jer time prebacujete pažnju sa sebe na publiku. Na primjer, zatražite da se prisutni 
predstave, da razgovaraju u parovima ili o grupama o nekoj ideji i sl. 
 
Možda Vam ova anegdota pomogne da shvatite da niste usamljeni u svome strahu od 
javnog nastupa i da mnogi osjećaju isto. 
 
„Androklo je, kaže antička priča, bio rob, bačen u arenu s lavom, kao jedan od jadnika koji su 
svojim mukama trebali zabaviti dokoni rimski puk. No, lav ga je poštedio... U trenutku kobnog 
susreta u rimskoj areni, Androklo je nešto šapnuo lavu, a ovaj se uplašio, podvio rep i vratio u svoj 
kavez, ne pojevši ga. Na upit cara što mu je rekao, Androklo je odgovorio: 'Rekao sam lavu da će 
nakon objeda morati održati govor za nazočne!?“19 

 

                                                 
18 Andrew Leigh i Michael Maynard, Savršena prezentacija: Put i način da uspete od prve, Prevod, 

(Beograd: Javno preduzeće „Službeni glasnik“ i Institut za ekonomiku i finansije, n.a.), p. 66. 
 
19 Saša Petar, Recite to jasno i glasno – Osnove uspješne prezentacije, (Zagreb: Jakubin i sin d.o.o. Zagreb i 

Centar za poduzetništvo Osijek, 1999.), p. I 
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*** 
Zapamtite! 
 
„Ako želite da se Vaša prezentacija pamti..., morate da imate na umu ovih pet tačaka: 
Počnite žestoko – naglasite glavne tačke na početku svog govora; 
Redovno ponavljajte – stalno pominjite ključne tačke; 
Ističite na neobičan način – izlažite ključne tačke duhovito, na izvanredan ili neobičan 
način; 
Maksimalno angažujte publiku – stvorite mnoštvo mogućnosti za angažovanje publike 
tokom prezentacije; i 
Efektno završite – na kraju ponovo naglasite svoje glavne tačke: neka kraj odjekne!“20 

                                                 
20 Michael Gelb, Predstavite sebe: Kako osmisliti i održati upečatljive i nezaboravne prezentacije, (Beograd: 

FINESA, 2003.), p. 42. 
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